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Introduction 
Congratulations on your purchase of Bulldog Plus to manage your Uninterruptible 
Power Supply (UPS).  Bulldog Plus is designed to provide end users the ability to take 
proactive steps to protect their equipment from power related damages. Bulldog Plus 
allows for automatic shutdowns, scheduled shutdowns and a variety of other features 
that help you manage your system and its peripheral components. 
 
Bulldog Plus provides detailed information about the UPS and its protected equipment. 
It is easy to install and program, yet has the necessary features to handle all of one’s 
power requirements. Included is the capability for network management protocol 
(SNMP and DMI).  Bulldog Plus will disseminate UPS information into SNMP protocol 
and project it to the appropriate Network Management Station (NMS), such as HP 
OpenView. To make use of resources on the Internet, Bulldog Plus also supports HTTP 
protocol. This enables end-users to monitor their UPS anywhere, anytime, by simply 
utilizing their web browser 
 
Bulldog Plus runs in the background as a UNIX daemon, and communicates with the 
UPS in order to ensure that your computer and attached components are protected 
from any power problems. 
 
Bulldog Plus features: 
1.Graceful operating system shutdown  
2.Schedule test, shutdown/restart UPS, turn on/off receptacles  
3.Flexible events  
4.Notification: Pager, e-mail and audible alarm, network broadcasting and SNMP  
5.real-time values of voltage, current, frequency and loading...  
6.History data & graph  
7.Network monitor  
8.Multi-computer shutdown/restart  
9.Support Simple Network Management Protocol (SNMP)  
10.Support HTTP, remote monitor and control using Internet browser  
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 Bulldog Plus Installation 
System Requirements: 
1. To use Bulldog Plus, your system must be running one of the following operating 

systems: 
z Linux  
z FreeBSD 
z SCO OpenServer 5.0 
z SunSoft Solaris 8/9 for Intel processor 
z SunSoft Solaris 2.5/2.6/7/8/9 for SPARC processor 
z Hewlett Packard HP-UX B.10.20/B.11.0 
z IBM AIX 4.3 

2.  Bulldog Plus Monitor must run on X11R6 or above. 

Bulldog Plus Setup: 
1. Turn off your computer. 
2. Attach the electrical power cable from the computer to the UPS. 
3. Attach the electrical power cable from the UPS to an AC power outlet. 
4. Plug the communication cable into the UPS, then plug the other end of the cable 

into the communication port on your computer. 
5. Start your computer. 
6. To setup Bulldog Plus, please login to your system as a supervisor (root). 
7. Place the Bulldog Plus CD in your CD-ROM drive and change the working directory 

to /Unix/YourUnix, where YouUnix is the name of your Unix System. For example, 
/Unix/Linux or /Unix/Sun. 

8. Copy the only one file, YourUnix.tar,  in your working directory to directory /tmp. 
9. Change your working directory to /tmp. 
10. Tar the file with the command: tar xvf YourUnix.tar. Note that some OS may require 

“-“ before arguments. 
11. Run ./install. 
12. Follow the instructions from the install program. 
13. After installation,  Bulldog Plus program files will be located in the directory 

/usr/local/bulldog or the user specified directory. 
Notice: Some OS may not activate COM port as default. Thus, make sure the COM 
port connects to UPS has been activated before running  Bulldog Plus. 
The Bulldog Plus software is comprised of two modules: 
z UPS Monitoring Module (Bulldog Plus Service, file name: upsd), that runs in the 

background as a daemon process on your system and communicates with the 
UPS.  



 

Belkin Components 6

z User Interface Module (Bulldog Plus Monitor, file name: monitor) that enables 
you to control and configure Bulldog Plus through the drop down menus and 
dialog boxes. It also allows you to monitor the UPS through the Main Screen.  
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 Bulldog Plus Service 
Bulldog Plus Service, which runs in the background, is a daemon process when the 
system starts up. You can also run Bulldog Plus Service manually by typing the 
command ./upsd in the installation directory.  To stop Bulldog Plus Service, type the 
command ./upsd stop in the installation directory. 
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 Bulldog Plus Monitor 
Bulldog Monitor enables you to control and configure Belkin Bulldog through drop 
down menus and dialog boxes. It also allows you to monitor the UPS through the Main 
Screen. Bulldog Monitor does not need to reside in memory; the execution depends on 
the user’s requirements. This can save precious system resources and maintain a 
higher level of performance. 

After finishing the Belkin Bulldog installation, Bulldog Service automatically loads into 
memory and runs once the Windows operating system has started. The Belkin 
Bulldog icon, which lies on the system tray, will indicate the current UPS status.  

To run the Bulldog Plus Monitor, change your working directory to the installation 
directory and type the command ./monitor.  

 Bulldog Plus Monitor Main Screen: 
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Networking 
Bulldog Plus software is comprised of two modules:  Bulldog Plus Service and Bulldog 
Plus Monitor. You may run both the programs to monitor your localized UPS or run the 
programs on two different computers. 

1. Multi-Computer Shutdown. 

 
Bulldog Plus Service can operate in "Master" Mode (which allows Bulldog Plus to send 
commands to its connected UPS) in "Serial Slave" mode (which listens to its connected 
UPS) or in "Networking Slave" mode (which obtains UPS information from the  Master 
unit via the network). If two or more computers are communicating with a single UPS, 
only one of these computers should be in Master mode; the others should be in Slave 
mode to prevent them from sending contradictory commands.  
If a computer does not connect to the UPS directly but is powered by the same UPS, 
this computer called the Slave. Master communicates to Slave via a TCP/IP network. 

When a power event occurs, Master (Bulldog Plus Service) gets the information and 
then transmits it to the Salve(s) (Bulldog Plus Service). Each Bulldog Plus Service 
executes different "Actions" (FlexEvent) such that the system manager can configure a 
different strategy for each different computer. For example: When power fails, the file 
server and mail server won't shutdown until the UPS battery is low but other less 
important workstations will execute shutdown after 5 minutes and the other 
workstations shutdown after 10 minutes. Shutting down workstations preserves battery 
power for network servers. 
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Remote Monitor And Control 
2. Remote Monitor and Control:  Bulldog Plus Monitor. 

 Bulldog Plus Monitor has the ability to monitor Local host and Remote hosts. 

 
You can run Bulldog Plus Monitor without running Bulldog Plus Service, Bulldog Plus 
Monitor will search hosts in the LAN (Local Area Network) that are running Bulldog Plus 
Service in the combo box. Click on the Host Selection combo box and it will provide a 
list of the searched hosts in the LAN. Select one, then Bulldog Plus Monitor will connect 
to the selected host. 

 

If the host is located on the internet, so you can also input the remote host IP address 
from the View – Remote Hosts menu to establish the connection. 
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Remote Monitor And Control (cont.) 
3. Remote Monitor and Control: Internet Browser. 
Another method for remote monitoring with Bulldog Plus Service is by using the Internet 
Browser. Launch the Microsoft Internet Explorer or Netscape Communicator, type the 
IP address in the URL and press enter you will get the UPS information. You can 
change the network port number to prevent conflict with other WEB server programs. If 
the port number is not 80 you have to type URL like this: http://172.16.176.141:2000 
where 2000 is the port number you assigned. 
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 Bulldog Plus Monitor Operation 
The Main Screen has 7 areas that present information on the operating status of your 
UPS. These areas are discussed in the following sections. 

 
Host Selection: Press the combo box to select hosts that runs Bulldog Plus Service in 
the LAN. Users can monitor or control (need password) the UPS remotely.  

Connection Indication: The sine wave will appear while the communication between  
Bulldog Plus Monitor and  Bulldog Plus Service is established.  

Information Display: Press Bottom Layer Buttons to change the information that is 
displayed in this area.  

Recent Event Log: Shows the last 10 event logs in the combo box, click on the combo 
box to pull down and see the logs.  
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Top Layer Buttons 
Top Layer Buttons 
These buttons are used to increase the speed of your operations. 

Refer to the dialog boxes in the menu. 
Configuration: Same as the System-> Configuration in the menu.  
Meters: Same as the View-> Meters in the menu.  
Event Log: Same as the View-> Event Log in the menu.  
History Graph: Same as the View-> History Graph in the menu. 
 
 Bulldog Monitor Main Menu 
The Main Screen has a menu bar at the top with 4 main options: 

System: This menu allows you to set the Bulldog Plus  diagnostics and computer 
parameters.  
Control: This menu allows you to set UPS alarms, outlets, and tests.  
View: The View menu allows you to see the real-time values and history events/data.  
Help: The Help menu allows you to access the online help system. 
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System Menu 
The system menu allows you to configure the UPS and monitor screen parameters. 
When you select the System menu from Main Menu bar, a drop down menu appears 
offering you the following menu options: 

Login: Used for Remote Monitoring. User must enter the 
password verification before he/she can control or configure the 
UPS.  
Configuration: The Configuration menu allows you to tailor 
various Bulldog Plus parameters.  
Monitor Screen: Allows you to change display items in the 
Scroll screen of the Information Display Area. 
 
 

 
Window: This menu allows you to change the display items in the Information Display 
Area. The items in the menu refer to each button in the Bottom Layer Buttons.  
Close Monitor: Stop Bulldog Plus Monitor. 
 
Login 
When Bulldog Plus Monitor becomes a Remote Monitor (connects to different host) you 
have to enter the pass the password verification if you want to do configuration or 
control the UPS, otherwise, you can only view the UPS information. 
If the user runs Bulldog Plus Service and Bulldog Plus Monitor in the same computer, 
you can set your configurations or control the UPS without a password. 
To change your password, please choose the Set Password from the Configure - 
Network menu 
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System Menu (cont.) 
Monitor Screen 

This dialog box allows you to change display item in the Scroll screen of Information 
Display Area  
a. Meters: Press the Main button in the Bottom Layer Buttons, there are two meters in 

the information area. You can change the display items of the two meters.  
b. Scroll Window: Press the Scroll button in the Bottom Layer Buttons, the scroll 

window display in the information area. This item allows you to change the display 
step and items. 

Window 
This menu allows you to change the display items in the Information Display Area. The 
items in the menu refer to each button in the Bottom Layer Buttons. 
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System Menu (cont.) 
Close Monitor 
Close Bulldog Plus Monitor and leave  Bulldog Plus Service running. 
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Configuration Window 
The Configuration Screen has a menu bar at the top with three main options: 
Devices: This menu allows you to configure modem, pager and e-mail.  
UPS: The UPS menu allows you to plan the UPS schedule or do the Action. 
Network: This menu allows you to choose Master/Slave or configure SNMP, HTTP 
functions. 
 
Configuration Window 
UPS Communication Port: COM1, ... COM4.  Port names are different from systems. 
Next UPS Test Date/Time: The date of the next user-initiated UPS self test. Setting 
from System->Configuration->UPS->Schedule.  
Next UPS Shutdown Date/Time: This field displays the date of the next shutdown the 
computer and UPS. Setting from System->Configuration->UPS->Schedule.  
Next UPS Restart Date/Time: The date of the next restart.  Setting from System-
>Configuration->UPS->Schedule.  
Local Host IP: IP address of a computer, that runs Bulldog Plus Monitor.  
Bulldog Service Mode:  Bulldog Plus Service acts as a Master or Slave.  
Remote Host IP: The host, that runs Bulldog Plus Service. If Bulldog Plus Monitor and  
Bulldog Plus Service run on the same computer this field will be empty. 
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Devices Menu 
Devices  

Modem: To let Bulldog Plus notify you via pager, you must setup the modem device.  
Bulldog Plus will control the modem device using AT Command as default. 

a. COM Port: The 
communication port 
COM1, ...COM4.  
b. Baud Rate: Define the data 
transmitting speed.  
c. Initialize String: The string, 
that is sent to the modem 
before paging is attempted.  
d. Dial Prefix: The string, that 
is added to the beginning of 
each Pager Number before 
they are sent to the modem.  
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Notification Users: Pager List 
Notification Users -- Pager List: The program will dial the modem to notify all of the 
pager numbers that are listed on the pager list.  You can input your pager number by 
yourself. For example if, 060123456 is your pager number, each ',' tells the modem to 
delay 2 seconds, the delay time is for waiting the response signal from switching then 
transmit the display number 119. 119 will appear on your pager LCD.To trigger the 
pager notification you must enable the Pager Action in the Action dialog box.  

a. Add: Add a new pager number.  

b. Modify: Modify the selected pager number.  

c. Delete: Delete the selected pager number.  
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Notification Users: E-Mail 
Notification Users -- E-Mail: You can also e-mail information to users when power 
events occurs. The program utilizes the “send mail” command to transmit information to 
the assigned users. 

To trigger the e-mail notification you must enable the e-mail Action in the Action dialog 
box.  

a. Add: Add a new user.  
b. Modify: Modify the selected 
user name.  
c. Delete: Delete the selected 
user. 
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Notification Users: Network Broadcast 
Notification Users -- Network Broadcast: You can also broadcasting information to 
users when power event occurs. To trigger the broadcasting notification you must 
enable the Broadcast Action in the Action dialog box.  

 
a. Domain: Enable this item to 
broadcast all the users in the 
domain, otherwise Bulldog Plus 
will send messages to the 
hosts that user assigned.  
b. Add: Add a new machine 
name.  
c. Modify: Modify the selected 
machine name.  
d. Delete: Delete the selected 
name.  
 
 
 

Close: Close the Configuration window. 
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UPS Menu 

 
UPS Property: This dialog box allows you to configure the UPS COM port, battery 
replacement date,... etc.  Load Warning and Load Severity are used to prevent UPS 
overload (see the UPS hardware user's manual). Load Warning will notify the user to 
reduce the load of the UPS. Load Severity will shutdown the computer to prevent 
overload.  
 

a. COM Port: 
COM1, ...COM4.  
b. Load Warning: Load 
warning.  
c. Load Severity: User 
must reduce UPS loading.  
d. Last Battery 
Replacement Date: 
Record last battery 
replacement date.  
e. Next Battery 
Replacement Date: The 
date of next battery 
replacement, Bulldog Plus 
will notify user to replace 
the battery.  
f. Host Name: Local host 
name.  
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UPS Menu (cont.) 
Attached Devices: Assign the attached device name. When you are controlling the 

outlet,  Bulldog Plus will let you know which devices you are controlling.  
 

a. Select an Outlet Group: Assign an outlet group. Please see the back panel 
carefully, for some outlets may share one control relay, these outlets are called 
the outlet group. If you turn off outlet group1(for example: outlet1 and outlet2) 
then the UPS will stop power output to outlet1 and outlet2.  

b. Device Name: Assign the attached device names, for example: Outlet Group1 is 
for printer, Outlet Group2 is for computer. These records can improve the 
efficiency of your management. Don't forget to press the Update button.  

c. Update: Update your change.  
 

Log Management: (Please consider about the free space in your hard disk)  
a. Maximun Event Log Entries:   
Bulldog saves less than the 
assigned entries of the event log.  
b. Data Log Interval: Time to save 
a record of UPS data.  
c. Maximun Data Log Storage: It 
allows you to save how many 
months of UPS data files.  
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Schedule 
Schedule: This function allows you to shutdown, restart, test and turn on/off an outlet. 
You can schedule up to 6 events. Setting is based on day, week or month and up to a 
period of 2 years.  

Choose the applicable schedule to set whether it be for:  
a. One Time: This set schedule is applicable for a single day.  
b. Daily: This set schedule is applicable for every day  
c. Weekly: This set schedule is applicable for once a week period.  
d. Monthly: This set schedule is applicable for once a month period.  



 

Belkin Components 25

Action 
Action: The action menu provides you with a list of events to choose from. The event 
and/or any combination of these actions can be selected from the Choose Event list 
box. Actions that are already enabled will show a check mark. To delay the actions, set 
the desired time for delay in the Delay combo box.  

 
a. Enable Auto-Save:  Bulldog Plus Service running on MS Windows will save 

opened files and close applications automatically when you enable this function. 
b. Choose Event: When you select one item in the list the action buttons will 

display current setting. Press the button to do further configuration.  
c. Set Default: Set all the actions to their default values.  
d. Delay: The power event must occur within the delay time to trigger actions.  

 All the actions will be described here.  
Stop All Action: Clicking on this terminates all the actions immediately.  
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Action: Shutdown 
Action - Shutdown:  
Shutdown/Hibernate/Suspend the operating system or 
shutdown UPS. Both Hibernate/Suspend are available 
only on MS Windows. If you select shutdown item,  
Bulldog Plus will execute or ignore the Auto-Save 
function depending on your selection (in the Action 
dialog box). But if you select the suspend or hibernate 
item, the program will ignore the Auto-Save function. 
The functions of shutdown, hibernate or suspend are 
the same as if you select the Shutdown... from 
Windows Start menu.  
 
 
 
 
 

 
 

Action - Logging: Permits you to log 
events as well as modify default logging 
messagex. You can see this message in 
the Event Log dialog box.  
 
 
 
 
 

 
 

Action - Broadcasting: Permits you to 
broadcast an event based on a set 
period of time. If you want to be notified 
once, set the time period to "0". However, 
if you want to be notified more than once, 
set the time period to a larger number. 
Each number corresponds to the times of 
notification.  
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Action: Paging 
 

Action - Paging: Permits you to set the 
time period of paging intervals. If you 
want to be notified once, set the time 
period to "0". However, if you want to be 
notified more than once, set the time 
period to a larger number. Each number 
corresponds to the times of notification.  
 
 
 
 
 
 
 
 
 
 
Action- Command: Permits you to 
execute command files and set a period 
of time to delay its activation. To enable 
or disable this action, mark the Enable 
Command check box.  
 
 
 
 
 

 
Action - Alarm: Permits you to send out audible 
alarm instead of a broadcast message. There is 
only buzzer alarm for Bulldog Plus on UNIX. If you 
want to be notified once, set the time period to "0". 
However, if you want to be notified more than once, 
set the time period to a bigger number. Each 
number corresponds to the times of notification.  
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Action: E-Mail 
Action - e-mail: Permits you to send 
mail. If you want to be notified once, set 
the time period to "0". However if you 
want to be notified more than once, set 
the time period to a larger number. Each 
number corresponds to the times of 
notification. You can edit the user list by 
clicking the Edit list button, and add, 
modify or delete any user name in the list. 
To enable or disable this action, mark 
the Enable e-mail check box.  
 
 
 
 
 
 
 
 
 

 
Action - SNMP Trap: Lets you send a SNMP 
trap when the relative power event occurs. To 
enable or disable this action, mark the Enable 
SNMP Trap check box. You also need to specify 
the SNMP Trap target hosts and community 
string, please see the SNMP dialog box in the 
Network menu.  
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Action: Receptacle Control 

Action - Receptacle Control: Permits you to control Receptacle Relay on or off. Each 
Receptacle Relay may control only one outlet, please see the rear panel of your UPS or 
the UPS hardware user's manual.  
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Voltage Sensitivity 
Voltage Sensitivity: Adjust the UPS voltage sensitivity.  

 
Transfer Voltage: Change the low transfer voltage and high transfer voltage. This 
function lets your UPS suit the local power environment.  
 
a. Low Transfer Voltage: When utility power voltage is lower than the assigned value, 

the UPS will switch to backup. The output power 
is supplied from battery.  
b. High Transfer Voltage: When utility power 
voltage is higher than the assigned value, the 
UPS will switch to backup. The output power is 
supplied from battery. 
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Advanced UPS Property 
If your UPS doesn't support this function, the item 
will display a grayed area and the user cannot 
select this item.  
Enable Wakeup Computer: If your computer’s 
architecture is compatible to ATX and the BIOS 
supports RS-232 (RI) Wakeup function. You 
should enable this item to make the Schedule 
work correctly.  
Enable Resume Computer: Be sure the BIOS 
supports RS-232 (RI) Wakeup function. When  
Bulldog Plus suspends the computer and the UPS 
detects the change of power status, UPS will 
resume the computer and let  Bulldog Plus notify 
the users.  

Enable Power Fail, Auto-Reboot: The time-line depicts the process described.  
If you enable this function, the UPS will reboot to restart the computer. Otherwise, it will 
return back to its normal state.  
Enable Economic Mode: Switch to UPS economic mode.  
UPS Periodic Auto-Test: Daily, weekly, biweekly and monthly. UPS starts the test 
procedure automatically when it reaches the test time. 
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Network Menu 
Network : 

Set Password:  
Set the  Bulldog Plus Service password.  
 
 
 

Choose Master/Slave:  
Set  Bulldog Plus Service mode. If the 
computer is connected to the UPS directly (with RS-232 cable or USB cable) then the  
Bulldog Plus Service acts as a Master, otherwise it is a Slave. When  Bulldog Plus 
Service is a Slave you must assign the Master IP address so that the Slave can 
connect to the Master host and obtain the UPS information.  
 

a. Master: Configure the Bulldog Plus Service to be a Master. The Master will 
forward the UPS information to a connected Slave(s).  

b. Slave: Configure the Bulldog Plus Service be a Slave.  
c. Master IP Address: When Bulldog Plus Service becomes a Slave you must 

assign the Master IP address such that the Slave can connect to the Master host 
and get the UPS information. If you leave the item empty or type a wrong 
address, Bulldog Plus will show a disconnected message. 
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Remote Wakeup 
Remote Wakeup:  
To wake up the remote host, Bulldog Plus sends a SNMP Packet through the network. 
You must give the IP address and the network hardware address (MAC address) of the 
remote host. In Windows98, you can execute the "ipconfig /All" command under MS-
DOS prompt to get the network card physical address of the local host. Or, input the 
"arp -a" command to see the remote host’s physical address. Your network card must 
support the remote wakeup feature and this function should be enabled.  

a.  Bulldog Plus awakens the 
computer from Suspend Mode:  
Bulldog Plus awakens the 
computer from suspend mode 
(input power failed or other power 
events), and program will wake up 
the remote hosts that enable this 
item when the local host is woken.  
b. Each Time Bulldog Plus 
Startup: Program will wake up the 
remote hosts that enable this item 
when  Bulldog Plus starts up and 
connects to the UPS.  
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SNMP 
Select the Accept SNMP 
packet from any hosts, 
Bulldog Plus will accept all 
the requested commands 
and set commands. When 
you select the Accept SNMP 
packet from the following 
hosts, Bulldog Plus receives 
only the hosts that you as-
signed. Once the power 
event occurs and the user 
enables the SNMP Trap in 
the Action dialog box, 
Bulldog Plus will send the 
SNMP trap to the hosts that 
are listed in the Trap Target 
list box. To add, modify or 
delete the host, click on its 
respective command button.  
 
If the Bulldog Plus Service 
you are connecting is 
running on UNIX series, 
and Windows 95/98 
operating system, you can 

configure the SNMP parameters directly from the Bulldog Plus:  
Select the Accept SNMP packet from any hosts, Bulldog Plus will accept all the request 
commands and set commands. When you select the Accept SNMP packet from the 
following hosts, Bulldog Plus receives only the hosts that you assigned. Once the power 
event occurred and user enables the SNMP Trap in the Action dialog box, Bulldog Plus 
will send the SNMP trap to the hosts that listed in the Trap Target list box. To add, 
modify or delete the host, click on its respective command button.  
If the Bulldog Plus Service you are connecting is running on Windows NT or 
Windows 2000 operating system, you must install the SNMP Service and 
configure the SNMP parameters from your operating system:  
Bulldog Plus will ignore the values that were set in the SNMP dialog box. To change the 
parameters of SNMP function, you should install the SNMP Service in the Network 
option. Select the SNMP Service from the Network option in the Control Panel and click 
the Property button to do your changes. 
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SNMP (cont.) 
If the Bulldog Plus Service you are connecting to is running on Novell NetWare 
operating system, all settings in this SNMP configuring dialog will not take effect. 
Please edit the file SYS:\etc\Traptarg.cfg directly. 
 
SNMP Trap Number: 

Variable Trap No. Description 
dupsCommunicationLost 1 SEVER: Communication with the UPS failed 
dupsCommunicationEstablished 2 INFORMATION: Communication 

with the UPS reestablished 
dupsPowerFail 3 WARNING: Power failed! 

The UPS is operating on battery power 
dupsPowerRestored 4 INFORMATION: Power restored! 

The utility power restored 
dupsLowBattery 5 SEVER: The UPS batteries are low 

and will soon be exhausted 
dupsReturnFromLowBattery 6 INFORMATION: The UPS has returned 

from a low battery condition 
dupsLoadWarning 7 INFORMATION: Loading percent 

of the UPS over the Load Warning value 
dupsNoLongerLoadWarning 8 INFORMATION: Returnd from 

Load Warning condition 
dupsLoadSeverity 9 Warning: Loading percent of the UPS 

over the Load Severity value 
dupsNoLongerLoadSeverity   10 INFORMATION: Returned from Load 

Severity condition 
dupsLoadOnBypass 11 WARNING: The UPS loads on bypass 
dupsNoLongerLoadOnBypass 12 INFORMATION: The UPS is not on bypass 

mod 
dupsUPSFault 13 SEVER: A general fault caused in the UPS 
dupsBatteryGroundFault 14 SEVER: The UPS battery ground fault 
dupsNoLongerBatteryFault 15 INFORMATION: The UPS recovered from 

battery ground fault 
dupsTestInProgress 16 INFORMATION: The UPS test in progress 
dupsBatteryTestFail 17 SEVER: The UPS test in progress 
dupsFuseFailure 18 SEVER: The UPS fuse failed 
dupsFuseRecovered 19 INFORMATION: The UPS fuse recovered 
dupsOutputOverload 20 SEVER: The UPS overload 
dupsNoLongerOverload 21 INFORMATION: Recovered from UPS 

overload 
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SNMP (cont.) 
 

Variable Trap No. Description 
dupsOutputOverCurrent 22 SEVER: The UPS output over current 
dupsNoLongerOutputOverCurrent 23 INFORMATION: Recovered from UPS over 

current 
dupsInverterAbnormal 24 SEVER: The UPS inverter abnormal 
dupsInverterRecovered 25 SEVER: Recovered from UPS inverter 

abnormal 
dupsRectifierAbnormal 26 SEVER: The UPS rectifier abnormal 
dupsRectifierRecovered  27 INFORMATION: The UPS recovered from 

rectifier abnormal 
dupsReserveAbnormal 28 SEVER: The UPS rectifier abnormal 
dupsReserveRecovered 29 INFORMATION: The UPS rectifier abnormal 
dupsLoadOnReserve 30 INFORMATION: The UPS load on reserve 
dupsNoLongerLoadOnReserve 31 INFORMATION: The UPS no longer load on 

reserve 
dupsEnvOverTemperature 32 WARNING: The environment over 

temperature 
DupsNoLongerEnvOverTemperature 33 INFORMATION: The environment recovered 

from over temperatur 
DupsEnvOverHumidity 34 WARNING: The environment over humidit 
DupsNoLongerEnvOverHumidity 35 INFORMATION: The environment recovered 

from over humidity 
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HTTP 
 Bulldog Plus supports WEB Server for remote manager to get UPS information. User 
can use IE or the Communicator to connect to Bulldog Plus Service. Even if your 
computer doesn't install Bulldog Plus, you can monitor and control your UPS via the 
network.  

 
a. HTTP Root: The HTTP root path.  

All the html and gif files will be located here.  
b. Port Number: Default port number is 80 but if there is already one WEB server 

running you can change Bulldog Plus Service HTTP port number to a different 
number. At the Internet Browser you can input http://172.16.176.141:2000 in the 
URL where 2000 is the assigned port number. 
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Control Menu 
Control 

Shutdown Now: This command will execute the shutdown procedure at once.  
a. Restart: This function lets you restart the OS and 
UPS automatically after being shutdown. To start the 
OS and UPS for the next schedule, mark the Restart 
check box.  
b. Shutdown OS and UPS: Use this function to 
shutdown both OS and UPS.  
c. SHUTDOWN OS Only: Use this function to 
shutdown OS only.  
d. SUSPEND OS Only: Use this function to suspend 
your operating system.  
e. HIBERNATE OS Only: Use this function to 

hibernate your operating system.  
 
Cancel Shutdown: This menu enables you to terminate the current shutdown 
procedure.  
 
Turn Receptacle Relay On: Turn the selected receptacle relay on. 
Each Receptacle Relay may  control only one outlet, please see the rear panel of your 
UPS or the UPS hardware user's manual. 
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Control (cont.) 
 

a. Select a Receptacle Relay: Select a 
receptacle relay.  
b. Delay: Set the delay time to turn on the 
receptacle relay.  
c. Turn On: Execute the turn on command.  
 
 
 
 
 
 
 
 

Turn Receptacle Relay Off: Turn the 
receptacle relay off. Each Receptacle 
Relay may control not only one outlet, 
please see the rear panel of your UPS or 
the UPS hardware user's manual.  

a. Select a Receptacle Relay: Select a receptacle relay.  
b. Delay: Set the delay time to turn off the outlet group.  
c. Turn Off: Execute the turn off command.  

 
UPS Audible Alarm On: Enable the UPS alarm from the Bottom Layer Buttons. Press 
the Status button to obtain the UPS alarm status.  
 
UPS Audible Alarm Off: Mute UPS buzzer alarm.  
 
10 Seconds Test: UPS switches to backup mode and output power is supplied by 
battery in 10 seconds.  
 
Deep Battery Test: UPS switches to backup mode and output power is supplied by 
battery until the battery level is lowered and the test is over.  
 
Cancel Test: This menu allows you to stop testing the UPS immediately. 
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View Menu 

 

Meters: The Bulldog Plus supports up to 12 meters to be display in real-time values. 
Each meter has the ability to display all of the UPS values. Selecting different items 
from the Selection dialog box will display the selected item value.  

a. 2,4,6,8,12: Displayed meter number.  
b. Selection: Assign each meter to different UPS item value.  
c. Close: Close the meter window.  
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Event Log 
Event Log: This menu offers you the possibility of viewing past events.  

a. Exit: Close event log dialog box.  
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History Graph 
History Graph: Clicking on the History Graph opens a dialog box that contains 
information about UPS data in graph form. This information is available only if there is 
an accumulation of data. You can select the month and year you want to view.  

a. Horizontal Scale: Select the time scale.  
b. Vertical Scale: Select the value scale.  
c. Select Month: The UPS data for the month you want to view.  
d. Draw Item1(Blue): Denotes the UPS item value by blue line.  
e. Draw Item2(Red): Denotes the UPS item value by red line.  
f.  Update: Update the graph.  
g. Exit: Close the history graph dialog box.  

 



 

Belkin Components 43

History Data 
History Data: Clicking on the History Data opens a dialog box that contains information 
about UPS data in list form. This information is available only if there is an 
accumulation of data. You can select the month and year you want to view.  

a. Select Month: The UPS data in the month, that you want to see.  
b. Update: Update the list.  
c. Exit: Close the history data dialog box.  
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Remote Hosts 
Remote Hosts: Detect the hosts which running the Bulldog Plus Service in the LAN. 
You can also type in the IP address and connect to the WAN.  

a. Search Result: The hosts will be listed in the Search Result list box. Select the 
host you want to connect and press the Connect button to establish the connection.  

b. Connect to this IP address:  Bulldog Plus will connect to the IP address that 
you type in.  

c. Connect: Establish the network connection. 
 

Content: This online help.  
 
About:  Bulldog Plus version and copyright. 
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Bottom Layer Buttons 
Bottom Layer Buttons 

Each button shows the respective information in the Information Area. 
Main: General Information about the UPS.  
Tree: There are 2 sub-trees in the Bulldog Plus tree: System and UPS. System tree 
for host information and the status of Master/Slave connection, the UPS tree for all 
of the UPS information.  
Time: Displays the time of the schedule, battery replacement date and countdown 
time.  
Status: UPS status.  
Diagram: Indicate the UPS current flow.  
Scroll: UPS data graph.  
Outlet: Display outlet status. (If your UPS cannot control outlet then this button 
disappears)  
Network: Indicate the connection of Master/Slave, Bulldog Plus Monitor and  
Bulldog Plus Service. 
 

Main  
UPS Health: 3 levels: Green, yellow and red.  
UPS Type: On line, off line, line interactive or 3 phase on line.  
UPS Model: The UPS model, which is being monitored by Bulldog Plus.  
Firmware Version: Indicating the version status of the UPS internal code.  
Host Name: The host, which runs Bulldog Plus.  
Rating VA: The UPS rating VA.  
Rating Input Voltage: The UPS rating input voltage.  
Rating Current: The UPS rating current.  
Rating Battery Voltage: The UPS rating battery voltage.  
Rating Input Frequency: The UPS rating input frequency.  
Test Result: Results of the last self-test.  
AC Source: Normal, battery or bypass.  
Battery Status: The status of battery.  
Battery Level: Percentage of battery level.  
Loading: Output loading percentage.  
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Bottom Layer Buttons (cont.) 
Time  

Last Battery Replacement Date: To change the date of last battery replacement in 
the System-> Configuration UPS->UPS Property.  
Next Battery Replacement Date: To change the date of next battery replacement 
in the System-> Configuration UPS->UPS Property.  
Next 10 seconds Test Time: System-> Configuration UPS-> Schedule.  
Next Deep Test Time: System-> Configuration UPS-> Schedule.  
Next Shutdown UPS Time: system->Configuration UPS-> Schedule.  
Next Restart UPS Time: System-> Configuration UPS-> Schedule. 
 

Status  
Shows all of the UPS status readings, red light indicates that an event happened. 
 

Diagram 
Input and output power flow of UPS. 
 

Scroll 
Record the recent UPS data information.  You can change the display item from 
System->Main Screen. 
 

Network 
Display all the Bulldog Plus Service searched in the LAN. 
 

Outlet 
Display the UPS outlet status (If your UPS cannot control outlet this button 
disappeared). 
Status: Identify the current outlet status: Normal or shut.  
Next Turn Off Time: System->Configuration->UPS->Schedule  
Next Turn On Time: System->Configuration->UPS->Schedule 



 

Belkin Components 47

 

Service and Support 
 

Corporate Headquarters 
Belkin Corporation 

501 West Walnut Street 

Compton • CA • 90220-5221 • USA 

Tel:  310.898.1100 

Fax: 310.898.1111 

 

Customer Service/Sales: 

800.2BELKIN 

800.223.5546 

 

Technical Support: 

310.898.1100 ext. 2263 

800.223.5546 ext. 2263 

Fax: 310.604.2089 

techsupp@belkin.com

belkin.com/support/tech

 
United Kingdom 

Belkin Components, Ltd. 

Express Business Park 

Shipton Way • Rushden • NN10 6GL 

United Kingdom 

Tel:  +44 (0) 1933 35 2000 

Fax: +44 (0) 1933 31 2000 

 
France 

http://inside/intranetfiles/Bahoo/Belkin/Marcom/techsupp@belkin.com
http://inside/intranetfiles/Bahoo/Belkin/Marcom/belkin.com/support/tech
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Belkin SAS Components 

5 rue du Petit Robinson 

78 350 Jouy en Josas • France 

Tel:  +33 (0) 1 34 58 14 00 

Fax: +33 (0) 1 39 46 62 89 

 
Germany 

Belkin Components GmbH 

Hanebergstrasse 2 

80637 • München • Germany 

Tel:  +49 (0) 89 143405 0 

Fax: +49 (0) 89 143405 100 

 
The Netherlands 

Belkin Components B.V. 

Starparc Building • Boeing Avenue 333 

1119 PH Schiphol-Rijk • The Netherlands 

Tel:  +31 (0) 20 654 7300 

Fax: +31 (0) 20 654 7349 

 

European Customer Service/Sales: 
00 800 223 55 460  
eurosales@belkin.com

 

European Tech Support:  
00 800 223 55 460  
eurosupport@belkin.com

 
Australia 

Belkin, Ltd. 

7 Bowen Crescent • West Gosford • NSW 2250 Australia 

mailto:eurosupport@belkin.com
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Tel:  +61 (0) 2 4372 8600 

Fax: +61 (0) 2 4372 8603 

 

Tech Support: 

Australia Toll Free 1800 666 040 
New Zealand Toll Free 0800 441 913 

Singapore Toll Free 800 6161 790 

belkin.com/anz

 
China 

Belkin Shanghai Representative Office 

Suite 31 • 39/F • Plaza 66 

1266 Nanjing West Road   

Shanghai • 200040 • China 

Tel:  8621-62881747 

Fax: 8621-62881748 

 

Customer Service/Sales: 
china@belkin.com  
 

Tech Support: 
800-820-5816 
 

http://www.belkin.com/anz
mailto:china@belkin.com
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